
F L A T B E D  M E M O R I E S
Working with Your Scanner 

Scanners are both extremely useful and 
about as cheap a peripheral device as you 

can get. They allow you to take either images 
or pages of text and input them in digital form 

into your computer in much the same way as you 
duplicate a document on a copy machine. However, 
even as digital cameras are rapidly overtaking traditional film cameras as 
the photographic device of choice for the masses, the number of people 
using scanners to transfer their non-digital images into digital form is slowly 
decreasing. Despite this trend, scanners are not in immediate danger of 
extinction because there are more images around than those you take yourself.

Even though scanners have been around for a relatively long time, support 
for them in Linux is still a bit spotty. Fortunately, this is changing for the better 
with every new Linux release. The backend, the essentially hidden part of your 
system that handles scanner recognition and support in Linux, is called Sane. 
If you are wondering whether Linux will be able to recognize your scanner, or 
if you are trying to figure out what type of scanner to buy, you will probably 
want to go to the Sane website, www.sane-project.org/sane-mfgs.html. 
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There you will be able to see if your scanner is supported or to get tips as 
to what scanner to buy. As I have mentioned before, you can also try out the 
Xandros User Forums (http://forums.xandros.com) and ask for Xandros-
specific recommendations there. 

For those of you who have a scanner, now is the time to get a feel for how to 
use it with Xandros by following along with this project. To get started, make 
sure your scanner is plugged into your computer and turned on.

After that, here’s what you have to do:

1. Go to the Launch menu and select Applications  Graphics  Scanner. 
This will launch the scanning application known as Kooka.

Figure 10-1: The Kooka Welcome window 

2. The Kooka Welcome window (Figure 10-1) tells you which scanning 
devices you have connected to your machine and asks you to pick one. 
Assuming you have only one, just click OK. 

NOTE If the scanner you are using is the only one you are likely to connect to your machine in 
the near future, then go ahead and check the box next to the words “Do not ask on 
startup again, always use this device,” which will allow you to bypass this phase of 
the startup in the future. If you do happen to add, or switch, scanners in the future, 
you will be able to make the appropriate changes in the Kooka Preferences window at 
that time. Once you click OK, the main Kooka window will appear.

Now that Kooka is up and running, you can get down to some 
scanning. The first thing we’ll do is perform a preview scan. This is a 
quick, low-resolution scan, which allows you to see a thumbnail, a small 
version of the image you will be working with.

3. Choose a photo you would like to scan, place it on the scanner bed, and 
then close the cover.

4. Click the Preview Scan button in the main Kooka window, after which 
a small window (Figure 10-2) will appear showing you the progress of 
the scan. 

Project 10A: Scanning



F la tbed Memor ies 165

Figure 10-2: Kooka shows your scanner’s progress

Once your scanner has finished doing its thing, the progress window 
will disappear, and you will see a thumbnail of your image in the right 
pane of the main Kooka window, which at that point should look like 
Figure 10-3, though your preview image will (unless we move in surpris-
ingly similar circles) be different.

Figure 10-3: The main Kooka window after performing a preview scan

After the thumbnail preview of your image appears, you must select 
the part of it you want to scan. This can be a very handy feature, as it allows 
you to perform some after-the-fact digital magic. Imagine, for example, 
that you have a killer photo of yourself that you want to include in a 
digital photo album. The only problem is that standing at your side in 
that photo is your ex, Chris, who, given the course of things in your life, 
you would rather place squarely into the trash bin of your memory. Of 
course, rather than stave off a bout of heartbreak by removing your ex, 
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you might, as is the case with my happily married friend in Figure 10-4, 
just want to isolate a portion of a photo for use as a headshot in a web 
page or on a letterhead. 

Even if you have no need to erase or isolate someone in your image, 
and you instead want to scan the whole image, you still have to make a 
selection, in this case from image border to image border. If you don’t 
do this, your scanner, not knowing any better, will scan the entire area of 
its scanning bed, thus producing an image with an enormous amount of 
empty white space. In all likelihood, this is something you want to end 
up with about as much as eggshells in your omelet.

Figure 10-4: Selecting the portion of the image you want to scan

5. To make the selection, place your cursor at one corner of the image or 
part of the image you want to scan (the cursor’s shape will change from 
the traditional arrow to a crosshair), press and hold down your left mouse 
button, and then drag the cursor until you have surrounded the area you 
want to scan with the dashed selection box (sometimes referred to as 
“marching ants”) that then appears (Figure 10-4). Release the mouse 
button.

If you are selecting only a relatively small area of an image, as in the 
example we’re using, it would behoove you to increase, perhaps by twice, 
the resolution so as to end up with a clearer final image. You can adjust 
resolution settings by using either the slider or the up arrow in the main 
Kooka window next to the word Resolution (Figure 10-5). 

Figure 10-5: Changing the resolution for the final scanned image

6. Now that you have selected the area you want to scan, click the Final 
Scan button to seal the deal. 

A progress window like the one you saw during the preview-scan 
phase of things will appear again, and, after your scanner spurts out a 
few tugging sounds, you will hear the long, steady hum of your scanner 
doing its job. During this time the progress bar will begin its mercurial 
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journey to completion. When the scan is indeed complete, the progress 
window will disappear, and a Kooka Save Assistant window (Figure 10-6) 
will open in its place. 

Figure 10-6: The Kooka Save Assistant window

7. Choose a format in which to save your image (I use JPEG for images I will 
use on a web page and PNG for everything else), and click OK.

Viewing the Results
To see the results of your final scan, you will need to move your mouse over 
to the right pane of the main Kooka window (Figure 10-3), and then click the 
tab showing an icon of a folder and file. Since this might be a bit hard to make 
out, I’ve highlighted it for you in Figure 10-7.

Figure 10-7: Finding your final scan results

Once you click that tab, the results of your final scan will appear in the 
right pane of the main Kooka window, as you can see in Figure 10-8. 

You will also notice that a thumbnail of the image will appear at the 
bottom of the pane and that the default filename for that file will be listed in 
the left pane (in this case, kscan_0001.png).



168 Chapter 10

Figure 10-8: The final result of your scanning efforts

Getting a Fuller View

Of course, especially when dealing with larger images or images scanned at 
much higher resolutions, most often only a part of your final image will be 
visible in the right pane, as you can see in the left part of Figure 10-9. This is 
simply because the final image is too big to fit in the relatively small area 
provided in the Kooka window.

Figure 10-9: Viewing a scanned image before and after scaling 
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In order to see the entire image, go to the Image menu of the main 
Kooka window, select Scale to Height or Scale to Width, depending on what 
is appropriate in your case, and presto! You will then be able to see the whole 
image that you’ve just scanned (as in the right side of Figure 10-9).

Where Can I Find My Images?

Once you’ve finished scanning, you will no doubt want to use your images for 
purposes all your own. The only problem is that you might not be able to 
find them. So where are they?

Your images are actually located within your Home folder; however, 
the folder in which you can find them is hidden from your view and buried 
in /.kde/share/apps/ScanImages. You can dig your way to that folder after first 
going to the View menu in a Xandros File Manager window and then select-
ing Show Hidden Files. But there is a simpler way of doing things by which 
you can save your images to your My Pictures folder (or anywhere else you 
like), and give each of the files a more meaningful name in the process. After 
all, an image file with the name Christmas2005.png is certainly more meaning-
ful to you than one called kscan_0076.png, right? 

If this all sounds of interest to you, here’s what you need to do:

1. Right-click the image you wish to move and rename in the left pane of 
the Kooka window.

Figure 10-10: Saving your image in a new location (and with a new name)

2. In the pop-up menu that appears, select Save Image (Figure 10-10). 

3. In the Save As window that appears, navigate to the folder in which you 
wish to save your image.

4. In the File name box, give your image file a meaningful (to you) name.

5. Click Save, and you’re finished.
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Your scanned image will now actually be residing in two locations: the 
location to which you just saved it and the original Kooka Gallery location 
buried in the hidden-from-view .kde folder (/.kde/share/apps/ScanImages).

Since you don’t really need to have that copy in the Kooka Gallery 
anymore, you can save some disk space, and keep the left pane of your Kooka 
window a bit tidier, by deleting that original copy of the image. 

Accomplishing this is very similar to what you just did when you saved 
the image—just right-click the image you want to delete, select Delete Image 
in the pop-up menu (you can see the choice in Figure 10-10), and then in 
the window that appears asking you if you really want to delete it, click OK. 

Why Are My Scanned Images So Big?

This is a point that seems to confuse a lot of people, so I’ll talk about it a bit. 
One of the first areas of confusion is that there is a general blurring of how 
the terms ppi (pixels per inch) and dpi (dots per inch) are used. Most 
applications use these terms interchangeably, and yet they aren’t really the 
same thing. To make things simple, when you are talking about images on 
your screen, you are talking about pixels (the little dots that make up your 
screen image) per inch, and when you are talking about printer resolution, 
you are talking about dots (of printer ink) per inch. 

Your computer screen in general has a resolution of 76 ppi, while most 
modern inkjet and laser printers have a resolution range of 300 to 1200 dpi, 
sometimes even more. This means that a photo scanned at 76 ppi that looks 
just fine on your screen ends up looking pretty lame when you print it out. 
On the other hand, when you scan a picture at 300 ppi, the image will look 
much better in your printout but will seem gigantic on your screen. This makes 
sense, as the resolution of your image is more than three times that of your 
computer’s screen resolution. The result is that your computer can accom-
modate the higher resolution of the image only by displaying that image at 
three times its original size.

Figure 10-11: Same image scanned at three different resolutions 
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As an example, have a look at Figure 10-11, where you can see the 
identical image scanned at three different resolutions: 76 ppi, 150 ppi, and 
300 ppi. As you can see, the 76 ppi image at the far left (measuring 132 × 156 
mm—about the size of the hardcopy itself) is the smallest, while the other 
two images are proportionally bigger (265 × 313 mm for the 150 ppi image 
and 550 × 627 mm for the 300 ppi image).

So What Resolution Should I Use When Scanning? 
What resolution you use when scanning really depends on a variety of 
factors, the most important of which is what you plan to do with the image 
when you’re finished. When I look at Figure 10-12 on my computer screen, 
the smallest image looks best, the middle image looks okay, and the largest 
looks a bit odd, not as sharp as the other two. Basically, when scanning 
images for display on a computer, on web pages for instance, it is probably 
best to stick with a ppi similar to typical screen resolutions or slightly larger 
(76 to 150 ppi).

When it comes to printing, a whole new set of considerations comes 
into play. First of all, there are the limitations of your scanner, different 
models having different maximum resolutions. The resolution limits of 
your printer itself are also, naturally enough, a major consideration. These 
include the type of printer you have, since laser printers and inkjets have 
different characteristics; laser printers will produce better-quality images 
than inkjet printers, while inkjet output will be more greatly affected by the 
type of paper used than will a laser printer. In either case, there is always 
the question of the printing resolution you ultimately select. Of course, your 
printed output is not going to suffer if you scan your images at higher resolu-
tions than those at which you plan to print them out, but you will end up 
with a lot of files taking up too much disk space. Remember: the higher the 
resolution of a scanned image, the greater the file size in terms of disk space. If this is of 
concern to you, and you would prefer not being so cavalier with your use of 
disk space, you can follow these very general guidelines:

If you are using a laser printer, scan at the same resolution at which you 
are going to print.

If you are using an inkjet printer with regular paper, scan at about 65 per-
cent of your target printout resolution, about 195 ppi for a 300 dpi print.

If you are going to use an inkjet printer with photo-quality paper, scan at 
about 80 percent of your target printout resolution, about 240 ppi for 
300 dpi. 

Needless to say, these are just suggestions to get you started. What works 
best for you and your particular scanner/printer setup may be slightly differ-
ent. That said, it’s worth driving home the fact that nothing works better than 
a bit of experimentation and trial and error. In this case, you can’t really go 
wrong. Just give yourself some time, don’t get frustrated, and, most important, 
don’t wait until you desperately need to scan something before trying things 
out—stay ahead of the game.
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If all this talk about scanning versus printing resolutions has left you feeling 
as if you are locked inside a Dali painting, then you might want to join in 
on this little hands-on experiment. Once you have completed it, you should 
have a better idea of how resolutions translate into reality and what resolu-
tions work best with your printer. As a bonus, you’ll also get a little experience 
working with the OpenOffice.org application, Draw. To follow along, you 
will need one clear snapshot (preferably with at least one large object, such 
as a portrait) and, naturally enough, a scanner and printer. 

1. Scan your image at four different resolutions: 76, 150, 300, and 600 ppi. 
If your scanner cannot handle resolutions as high as 600 ppi, you can 
skip that one. Save the files that result as ex76.png, ex150.png, ex300.png, 
and ex600.png. Of course, you can name the files anything you want, but 
using my suggestions will make it easier for you to follow along. 

2. Open a Xandros File Manager window, and navigate to the folder in which 
you saved the images.

3. Select the four files you’ve just scanned by holding down your CTRL key 
and then clicking each file individually. When you are finished, the four 
files will be highlighted.

4. Now right-click any of the four files, and in the pop-up menu that appears, 
select Cut. The files will not immediately disappear at this point, so don’t 
worry.

5. Navigate to your Home folder, and right-click any open space. In the 
pop-up menu that appears, select Paste. The four files will then appear 
(and, incidentally, disappear from the source folder).

6. Run OpenOffice.org Draw by going to the Launch menu and selecting 
Applications  OfficeOffice.org Drawing Editor. 

7. Now go to the Insert menu in OpenOffice.org Draw, and select Graphics. 
An Insert Graphics window will then appear.

8. In that window, navigate to your Home folder by clicking the Home 
button (as shown in Figure 10-12).

Figure 10-12: Navigating to your Home folder in the OpenOffice.org Insert Graphics 
window 

9. In the list within that window, locate and select the first file you scanned, 
ex76.png, by clicking once on its name. The filename should then be 
highlighted like that in Figure 10-13. If so, click the Open button, after 
which the image will appear at its full size in OpenOffice.org Draw.

Project 10B: Getting a Grip on Resolutions
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Figure 10-13: Select the file you wish to insert into your OpenOffice.org file

10. Repeat the procedure you just performed in step 9, but this time select 
the file ex150.png. 

Figure 10-14: Inserted images appear in Draw at their original size

11. When the image appears, it will be noticeably larger than the first, as you 
can see in Figure 10-14. Resize the image so that it is the same size as the 
first by holding down the SHIFT key and then placing your cursor at one 
of the corners of the image. The cursor will then change into a double-
sided arrow. When it does, press your mouse button, and drag one of the 
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raised green squares at the corners of the image until the image is the 
appropriate size. If you don’t see any raised squares, click the image 
once, after which they will appear. In case you are wondering, holding 
down the SHIFT key as you do this keeps the proportions of the image 
intact.

12. Insert and resize each of the remaining two files, ex300.png and 
ex600.png, using the methods you used in steps 9 and 11. Once you 
have completed the insertion process, your OpenOffice.org Draw win-
dow should look like that in Figure 10-15. Be sure that your images are 
placed in the same order as mine so that you will be able to compare 
your printed results later on.

Figure 10-15: Your images set up to print 

13. Now that your page is set up, it’s time to print it out. Be sure to set your 
printer’s settings to print at 600 dpi, and use a good-quality paper, pref-
erably photo quality. Of course, if you are using a laser printer, your 
paper choice will matter much less. Once ready, print. 

While the four images will probably look more or less the same on your 
screen, there should be a noticeable difference in your printed output. On 
the basis of that output, you will be able to see what a difference a few hundred 
ppi can make and thus have a better idea what scanner settings provide the 
best results on your printer.


